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select EndNote Help (Macintosh) or Contents (Windows) to view help topics. While using EndNote, 
press Help (Macintosh) or F1 (Windows) to view a help topic about the current window.
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Introduction: Welcome to Thomson Reuters 
EndNote X5

EndNote—your complete reference 
solution! 

 EndNote is an online search tool—you can search online 
bibliographic resources and retrieve references directly into 
your EndNote library. You can also export references to 
EndNote from your favorite online resource (see “Direct 
Export Providers” in EndNote Help).

 EndNote is a reference and full text organizer with a 
collaborative Web tool—your personal reference library will 
save you countless hours of organizing your research. Group 
references according to your research projects and attach up 
to 45 files per record for managing related materials. 
EndNote can locate full text PDF files for you or create a 
reference when importing a PDF file. Transfer references, 
and now file attachments, to your EndNote Web account to 
share groups with other EndNote users easily and manage 
your ResearcherID publication list. 

 EndNote is a bibliography maker—Cite While You Write™ 

takes the pain out of citing and formatting references in Apple 
Pages ‘09, Microsoft® Word, and OpenOffice.org Writer 3 for 
Windows. You can also create bibliographies for other word 
processors using Format Paper (RTF files). There is simply 
no better tool than EndNote for handling diverse 
bibliographic style requirements.

EndNote and EndNote Web are collaborative tools to simplify 
working with colleagues.

See “What’s New in EndNote X5” on page 9 for a list of the most 
recent features added to EndNote.

For late-breaking news and updates, please go to: 
http://www.endnote.com/support.

About the Demonstration Version of 
EndNote and the EndNote Viewer

If you are working with the demonstration version of EndNote, 
you have 30 days after you first use the program to evaluate 
EndNote and all of its features. After those 30 days are up, the 
Introduction: Welcome to Thomson Reuters EndNote X5 5



demonstration version reverts to a feature-restricted EndNote 
Viewer.

NOTE: While you can see the entire list of Microsoft Word templates 
available with the full version of EndNote, the demonstration version 
includes only the Nature manuscript template specifications. Any of the 
manuscript templates you choose will launch the Nature manuscript 
template.

After the program reverts to an EndNote Viewer, you can still 
open EndNote libraries, search, sort, and print references. 

With the EndNote Viewer you will not be able to:

 Add or edit references in a library that has 10 or more 
references already in it. 

 Format more than 10 citations in a paper. 

 Retrieve more than 10 references from a remote database. 

 Import more than 10 references. 

 Export more than 10 references at one time. 

To purchase an unrestricted version of the EndNote program, 
open your trial version, and then click the Yes button when the 
EndNote dialog appears with the message:

     Would you like to activate the full version of EndNote?

You will need to purchase a product key in order to activate the 
unrestricted version of EndNote.

If you are upgrading from a previous version of EndNote, then 
you need to supply the product key and provide your name in the 
Name field.

About this Getting Started Guide
This guide provides a basic overview of installing and using 
EndNote. It is not a complete user’s guide, but rather is intended 
as a guided tour to show you the highlights of the EndNote 
program.

This guide assumes that you know how to use your Macintosh or 
Windows operating system and your word processor. For help on 
these topics, consult the documentation that comes with these 
product. 

Because this guide serves both Macintosh and Windows users, 
screen representations alternate between the Macintosh and 
6 Introduction: Welcome to Thomson Reuters EndNote X5



Windows versions. While the two platforms are essentially the 
same, there may be slight differences between the pictures 
shown in this guide and the windows that appear on your 
computer screen.

Often there is more than one way to select a command in 
EndNote. A single command may be available from one of the 
main menus, from a context-sensitive Control+click (Macintosh) 
or right-click (Windows) menu, from a toolbar, or with a keyboard 
command. In most cases, this manual gives instructions for 
selecting commands from the main menus. If a menu command 
has a keyboard equivalent, the keyboard command appears next 
to the menu item.

Customer Services

Register Your 
Copy of 
EndNote

You can register your software by either 1) creating or upgrading 
your EndNote Web account the first time that you start EndNote 
X5, or 2) by going to http://www.endnote.com/register. 
Registered users receive:

 Free technical support

 Special upgrade offers

 Notification of new EndNote versions that are compatible 
with the latest version of your word processor

NOTE: Even if you purchased EndNote directly from Thomson Reuters, 
do not assume that you are registered.

EndNote 
Online Help

Online Help: From EndNote’s Help menu, select EndNote Help 
(Macintosh) or Contents (Windows) to view the various topics. For 
context-sensitive help, click the Help or ? button found on various 
windows and dialogs or press the F1Help key on your keyboard.

The EndNote Manual: The online Help file is made available as 
a printable PDF file and is available from the “Overview of 
Thomson Reuters EndNote” topic in EndNote Help.

Release Notes: For documentation updates and correction 
notes for this release, refer to the Readme.txt file installed in the 
EndNote folder.

Late Breaking News: For late-breaking news and updates, go to 
http://www.endnote.com/support.
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Customer 
Service

Contact Sales for general product information, pricing, quantity 
discounts, and referrals to dealers. 

Contact Customer Service to order new copies or upgrades of 
EndNote, to check billing/shipping status, and to register your 
software.

Sales Information
Phone: 1 800 722 1227 (Toll Free)
Phone: 760 438 5526 (country code is 01)
Fax: 760 438 5573 (country code is 01) 
Web/Email: http://www.endnote.com/contact

Customer Support (Orders, Billing, and Shipping)
Phone: 800 336 4474 (country code is 01)
Fax: 215 386 2911 (country code is 01) 
Web/Email: http://www.endnote.com/contact

Support Contact Technical Support if you encounter problems while using 
EndNote. When you contact us, please have a clear description 
of the problem and know the version of your Windows operating 
or Macintosh system, EndNote, and word processor. To find the 
EndNote version and serial number, start EndNote and select 
About EndNote from the EndNote menu (Macintosh) or the Help 
menu (Windows).

For web/email or phone contact, including hours and holiday 
closures, please go to:
http://www.endnote.com/contact

Technical support tips are also available from the 
www.endnote.com/support Web site and the EndNote Discussion 
Forum.

International 
Customer and 
Technical 
Support

For customer support or technical support outside of North 
America, visit our Web site to check for a local distributor.

Go to http://www.endnote.com/distributors to find contact 
information for your local EndNote support.

Online 
Support

EndNote Web Site
The EndNote Web site (http://www.endnote.com) contains free 
training options including online videos and Web classes, a 
8 Introduction: Welcome to Thomson Reuters EndNote X5



technical support knowledge base, and information on the latest 
versions of EndNote. You can also find updated styles, filters, 
and connection files available for download.

EndNote Discussion Forums
If you wish to join an ongoing forum of EndNote users like yourself, 
go to http://www.endnote.com/forum. You can browse several 
EndNote message lists, easily search for topics, and join to add 
messages.

Join the EndNote social network at:

 www.facebook.com/EndNote

 www.twitter.com/EndNoteNews

 www.youtube.com/endnotetraining 

ADA VPAT Thomson Reuters is dedicated to developing software products 
that are usable for everyone, including those with physical 
challenges and disabilities. EndNote was designed to adhere to 
the ADA (Americans with Disabilities Act) Section 508 
accessibility standards.

Visit our Web site at http://www.endnote.com/vpat to access the 
VPAT (Voluntary Product Accessibility Template) document that 
describes the accessibility features that address the Section 508 
Standards.

The VPAT is an informational tool developed by industry and 
government to help facilitate the understanding of compatibility 
issues under Section 508.

What’s New in EndNote X5
The current release of EndNote includes the following new 
features:

 Add and transfer file attachments to references in your 
EndNote Web account for greater mobility. Upgrade or 
create your Web account with your EndNote X5 license to 
receive this expanded feature.

 View and annotate PDF files in the EndNote library new PDF 
& Quick Edit tab.

 Find Reference Updates on the Record Edit window to 
retrieve additional online data such as the PMCID required 
for NIH grants.
Introduction: Welcome to Thomson Reuters EndNote X5 9



 Select a new citation option – Author (Year) – within the Find 
& Insert My References dialog in Cite While You Write.

 Save time with new conditional formatting – substitute empty 
fields with alternates such as “Volume and Pages” with DOI. 
Support includes DOI, PMCID, and Editor/Translator 
conditions.

 Review duplicate references quickly with new auto-highlights 
for each field where differences are found.

 View the new Music reference type as well as new fields for 
NIHMSID and Article Number.

 Select from an expanded set of bibliographic styles, import 
filters, and connection files installed by default – or add more 
through customizing.

NOTE: Thomson Reuters recommends that you view our What’s New 
video at www.endnote.com/training or on your EndNote X5 CD.
10 Introduction: Welcome to Thomson Reuters EndNote X5



Chapter 1: Macintosh EndNote Installation

Before You Install EndNote 
Please read this section before you proceed with the installation.

If you are installing the full version of EndNote (not the Demo 
version), you will need a valid EndNote product key to install the 
program. If you are upgrading from a previous version, you will 
also need your previous EndNote product key or serial number. 

Program 
Requirements 

Both the full EndNote program and the EndNote Demo are 
available on CD or by downloading. If you have a CD you need a 
CD-ROM drive to install the program.

System Requirements

EndNote runs under Macintosh OS X (Intel only) versions 10.5.x 
(Leopard), 10.6.x (Snow Leopard), and 10.7 (Lion).

In the Finder, select About This Mac from the Apple menu to find 
your system version.

See the readme file on our Web site at http://www.endnote.com 
for the latest compatibility information about EndNote and 
released Apple operating systems.

Hardware Requirements

EndNote requires the following hardware:

 A Macintosh OS X (Intel only) 450 MHz or higher

 A hard drive with at least 400 MB of free space

 A minimum of 256 MB of available memory (RAM)

 In order to use EndNote’s Connect command, an Internet 
connection is required. To use the Open Link command to 
access a Web site, you also need a Web browser installed.

NOTE: Make sure that your computer meets the system and hardware 
requirements before continuing. If necessary, contact the distributor, 
dealer, or store where you purchased EndNote to arrange for a full 
refund. If you have any problem obtaining a refund, contact Thomson 
Reuters directly. You must do so within 30 days of purchase. 
Chapter 1: Macintosh EndNote Installation 11



NOTE: For Mac, check www.endnote.com/enmac.asp for the 
latest compatibility requirements.

Word 
Processor 
Compatibility

As of September 2011, EndNote for Macintosh is compatible 
with: 

 Microsoft Word 2008 (SP1) and 2011

 Apple iWorks Pages ‘09 versions 1, 2.x, 3.x, and 4.x

 RTF files created with most word processors,  including: 
Microsoft Word, WordPerfect, OpenOffice.org Writer,  
StarOffice, Nisus Writer, TextEdit, Mellel, and Scrivener.

NOTE: Endnote can also scan RTF documents created by 
Mariner Write if the documents are saved in Word's RTF and not 
Mariner Write's RTF.

Cite While You Write in Microsoft Word
EndNote’s Cite While You Write commands are available for 
Microsoft Word 2008 and 2011.

These Cite While You Write functions put an EndNote submenu 
of commands on Word’s Tools menu. They also allow EndNote 
to format citations and create a bibliography for the document 
that is open in Word. You can format, unformat, and reformat a 
single document without ever exiting your word processor.

If Microsoft Word 2008 or 2011 is installed on your computer, the 
appropriate Cite While You Write files are installed automatically 
when you run the EndNote installation.

Keep in mind that in order for Cite While You Write to install 
properly:

 Microsoft Word must be correctly installed on your computer 
prior to installing EndNote.

 All applications, including Microsoft Word, must be closed 
during the installation of EndNote.

 The EndNote installer must be able to locate the Word 
startup folder. You need to have full read and write access to 
Word’s startup folder in order to install EndNote commands.
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Cite While You Write in Apple iWorks Pages ‘09
EndNote commands are available on the Insert and Edit menus 
in Pages ‘09.

RTF and ODT Documents
For word processors other than Word, write your paper, insert in-
text citations, and then save to an RTF or ODT file to use 
EndNote’s Format Paper feature to format the citations and 
bibliography.

EndNote Installation
Follow these instructions to install the EndNote program. 

If you are upgrading from a previous version of EndNote, please 
see“Upgrading from an Earlier EndNote Version” on page 14 
before installing EndNote X5.

If you have purchased a Volume/Site License version of 
EndNote, please see “Networks and Volume Installations” in 
EndNote Help.

Installing 
EndNote

To install EndNote:
1. Make sure no applications are running—including virus 

protection software and Microsoft Word. 

2. Start the EndNote installation program.

If you downloaded the EndNote installer: Double-click the 
disk image to display an EndNote X5 folder.

If you received EndNote on a CD: Insert the EndNote CD 
into your CD-ROM drive. If the installer does not launch 
immediately, double-click the EndNote X5 Site Installer to 
display an EndNote X5 folder.

3. Drag the EndNote X5 folder to the Applications folder on your 
hard drive.

NOTE: The EndNote folder must reside in the Applications folder in 
order to use the Services menu from EndNote and Spotlight searching.

4. Double-click on the Applications folder, then the EndNote X5 
folder, then the EndNote X5 application icon in order to 
launch EndNote and a Customizer program.
Chapter 1: Macintosh EndNote Installation 13



5. Follow the instructions on the screen to complete the 
installation. Click the Next button to move forward as needed 
through the installation dialogs:

Welcome: Thank you for purchasing EndNote! 

Registration Key: If you are installing the full version of 
EndNote, enter your EndNote product key. You must enter a 
valid product key to continue with the installation of the full 
version of EndNote. The product key can be found in the 
EndNote X5 CD packaging or on the order confirmation of 
your digital product. 

If you are installing the Demo version, select the button to 
evaluate EndNote. You do not need a product key or serial 
number to install the Demo version of EndNote.

User Information: Enter your name and organization.

If you are upgrading from a previous version, you will also 
need your previous EndNote product key or serial number. 

Read Me: Read late-breaking news about this version of 
EndNote.

License Agreement: You must select “I accept the license 
agreement” in order to continue with the installation.

Product Registration: Please register your copy of 
EndNote!

When you start EndNote, a Customizer automatically installs Cite 
While You Write files for Microsoft Word 2008 and 2011 if any of 
them are found on your computer.

To make sure the EndNote program is installed correctly, see 
“Checking Your Installation” on page 17.

NOTE: If you use a non-English version of Word, see page 18.

Upgrading from an Earlier EndNote 
Version

While it is not strictly required, we recommend that you uninstall 
older versions of EndNote before installing your new version of 
EndNote. 

Back up your files
Before you begin, it is important to back up your EndNote 
libraries (including corresponding .DATA folders), custom styles, 
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import filters, connection files, and spell check dictionaries, as 
well as any Word documents that use Cite While You Write. 

Uninstall the older version of EndNote
It is best to check the uninstall instructions supplied with your old 
version of EndNote, as the instructions below are not valid for all 
older versions of EndNote.

1. Start the older version.

2. From the EndNote menu, select Customizer. 

3. Select all of the options, and then click Uninstall. 

4. Click Next and follow the prompts.

Install EndNote X5
Install the upgrade just as you would a new installation. See 
“EndNote Installation” on page 13. During installation, you will 
need to enter both your new EndNote X5 product key and your 
old EndNote product key or serial number. EndNote X5 is 
installed into an EndNote X5 folder. 

After installing EndNote X5, you may have two folders with each 
containing EndNote files. 

If you have backed up customized styles, filters, or connection 
files, you should also copy them to the Styles, Filters, or 
Connections folders in the EndNote X5 folder. EndNote includes 
a full collection of updated files, so unless you have specially 
customized a file for your needs, there is no reason to copy the 
old files.

To copy custom dictionaries from EndNote X or earlier versions 
to the new Mac OS spell checker, see “Importing Dictionaries” in 
EndNote Help.

Once you have copied your customized files and libraries to the 
EndNote X5 folder, and EndNote X5 is up and running, you can 
drag any remaining items in the old EndNote folder to the Trash. 
Be careful not to delete any libraries, papers, or other items that 
you need.

To make sure that EndNote is using the most recent set of 
files:

1. Start EndNote.

2. Go to the EndNote menu and select Preferences.

3. Click on the Folder Locations item. 
Chapter 1: Macintosh EndNote Installation 15



4. If the folder paths do not include an EndNote X5 folder, click 
EndNote Defaults to update the paths.

Cite While You Write Users

If you have a Microsoft Word document that was formatted with 
an earlier version of EndNote, we recommend that you first make 
a backup of the file. 

If the file was created with EndNote 5-X2, use the new version of 
EndNote to format the document again. From Word’s Tools 
menu, select EndNote X5, and then select Format Bibliography. 
This updates the document to work with EndNote X5. 

If the file was originally created with an even older version of 
EndNote, you will need to unformat the citations with the old 
version of Word and the original EndNote Add-in before the 
document can be used by EndNote X5. If you no longer have 
access to the older version of Word or the old EndNote Add-in for 
Word, please contact Technical Support.

Opening and 
Converting 
Old EndNote 
Libraries 

EndNote X5 opens and uses libraries created with EndNote 8 
and later. It converts libraries created with even earlier versions 
of EndNote to the latest file format. 

To convert an older EndNote library:

1. Start EndNote.

2. From the File menu, select Open, and then select Open 
Library. 

3. On the file dialog, locate and highlight the old library, and 
then click Open.

EndNote will warn you that the selected library was created 
with an older version, and will ask for permission to convert it.

4. Click OK to convert the library. Name the new library and 
click Save. The conversion makes a copy of the original 
library in the latest file format and leaves the original library 
intact.

NOTE: Once you have opened and used a library with EndNote X5, you 
should use the library only with version X or later.
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Using Old 
Style, Filter, 
and 
Connection 
Files

You may have created custom content files with an earlier 
version of EndNote. EndNote X5 can use your custom styles, 
filters, and connection files that were created with EndNote 
versions 4.0.1-X2. Once you edit and save one of these files with 
EndNote X5, it is converted to the latest format, which can be 
used with EndNote versions 8 to X5.

All of the styles, filters, and connection files supplied with 
EndNote X5 have been updated to the latest format. The new 
filter and connection files can be used by previous versions of 
EndNote, with new fields simply ignored. However, the updated 
styles cannot be used with versions of EndNote prior to version 8. 

Customized reference types, temporary citation markers, and 
display fonts are all carried over from earlier versions of EndNote 
for use with EndNote X5.

Checking Your Installation

To Begin 
Using 
EndNote

To run EndNote, double-click the EndNote X5 icon found in the 
EndNote X5 folder. 

If this is the first time you have started EndNote, a Customizer 
will attempt to install Cite While You Write files for Word. 

Next, a dialog may ask whether you want to open a new EndNote 
Web account. For information about EndNote Web, see 
“Transferring References between EndNote Web and EndNote” 
in EndNote Help.

Then, a dialog will ask you to open a reference library file. You 
can create or open an EndNote library, or select Close. A Sample 
Library is provided in an Examples folder to help you get familiar 
with EndNote.

To check the EndNote version number, go to the EndNote menu 
and select About EndNote. Click the splash screen to clear it.

Checking 
Support for 
Microsoft 
Word

To see whether Cite While You Write is correctly installed:
Start EndNote, then start Microsoft Word, and then select the 
Tools menu. 

You should see EndNote’s Cite While You Write commands on 
an EndNote X5 submenu in Word.
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If you do not see these commands, Word support was not 
correctly installed. Try these three ways to install CWYW (after 
each attempt, start EndNote and then Word to check for an 
EndNote submenu on the Tools menu in Word):

1. Use the Customizer:

a. Make sure no applications are running—including virus 
protection software and Microsoft Word. 

b. Start the EndNote program.

c. From the EndNote menu, select Customizer.

d. On the Component Selection dialog, select the 
components you want to install (or keep installed) and 
click Next. 

2. Try reinstalling EndNote as described under “EndNote 
Installation” on page 13.

3. Install the files manually as described in EndNote Help.

Non-English 
Versions of 
Word

The EndNote installer uses English terms for the various target 
folders in the installation (such as “Word Startup Folder”). If you 
are running a version of Word localized for a different language, 
you may need to install Word support manually as described in 
EndNote Help.

Additional Topics
The installation chapter in EndNote Help includes these 
additional topics:

 Installed Files

 Custom Installations/Adding Content Files

The EndNote team has developed thousands of content files 
(output styles, filters, and connection files). Because 
installing all of these files can slow performance, a typical 
EndNote installation includes only the most popular of each 
type of file. It is easy to find and install additional content 
files!

 Manually Installing Support for Word 2008 or 2011

 Updating EndNote Files

 Uninstalling EndNote
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Chapter 2: Windows EndNote Installation

Before You Install EndNote 
If you are installing the full version of EndNote (not the Demo 
version), you will need a valid EndNote product key to install the 
program. If you are upgrading from a previous version, you will 
also need your previous EndNote product key or serial number.

Program 
Requirements

Both the full EndNote program and the EndNote Demo are 
available on CD or by downloading. If you have a CD you need a 
CD-ROM drive to install the program.

System Requirements: 
EndNote runs under the following operating systems: 

 Windows 7 (32 or 64 bit versions)

 Windows Vista (32 or 64 bit versions)

 Windows XP with at least Service Pack 3 installed

Hardware Requirements:
 A minimum of 256 MB of available RAM

 A hard drive with at least 400 MB of free space

 An Internet connection is required to access online 
databases using the EndNote Online Search feature, to run 
the Find Full Text feature, and to transfer references to and 
from EndNote Web. You will also need a Web browser to use 
the OpenURL Link and Open URL commands.

 Unicode compliant

NOTE: Make sure that your computer meets the system and hardware 
requirements before continuing. If necessary, contact the distributor, 
dealer, or store where you purchased EndNote to arrange for a full 
refund. If you have any problem obtaining a refund, contact Thomson 
Reuters directly. You must do so within 30 days of purchase. 

NOTE: For Windows, check www.endnote.com/enwin.asp for the latest 
compatibility requirements.
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Word 
Processor 
Compatibility

As of June 2011, EndNote for Windows is compatible with: 

 Microsoft Office Word 2003, 2007, or 2010 (32 or 64 bit 
versions) for Windows

 Open Document Format (ODT) documents created with 
OpenOffice.org Writer 3

 RTF files created with most word processors, including: 
Microsoft Word, WordPerfect, OpenOffice.org Writer, 
StarOffice, and WordPad

 Wolfram Mathematica 8

Microsoft Word
EndNote installs Cite While You Write commands in Microsoft 
Word. 

 Word 2003 displays an EndNote submenu of commands on 
Word’s Tools menu. 

 Word 2007 and 2010 displays Cite While You Write 
commands on an EndNote tab. 

Cite While You Write allows EndNote to format citations and 
create a bibliography for the document that is open in Word. You 
can format, unformat, and reformat a document without exiting 
your word processor.

In order for Cite While You Write to install properly, Microsoft 
Word 2003, 2007, and 2010 must be correctly installed on your 
computer prior to installing EndNote. Please make sure that you 
close Word and all applications before attempting to install Cite 
While You Write.

If a supported version of Microsoft Word is installed on your 
computer, the appropriate Cite While You Write files are installed 
automatically for the current user when you run the EndNote 
installation. This feature can be used with a shared copy of Word 
or on a network. 

OpenOffice.org Writer
EndNote installs Cite While You Write commands in the 
OpenOffice.org version 3 Writer. CWYW commands appear on 
an EndNote menu. Cite While You Write allows EndNote to 
format citations and create a bibliography for the document that 
is open in OpenOffice.org Writer. You can format, unformat, and 
reformat a document without exiting your word processor.
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In order for Cite While You Write to install properly, the 
OpenOffice.org 3.x suite must be correctly installed on your 
computer prior to installing EndNote.

You must close all OpenOffice.org applications before installing 
Cite While You Write, including the OpenOffice.org Quickstarter. 

RTF and ODT Documents
For word processors other than Word 2003, Word 2007, Word 
2010, or OpenOffice.org 3.x, first write your paper and insert in-
text citations. If the file format is anything other than an 
OpenOffice.org ODT document, save as an RTF file. Then, use 
EndNote’s Format Paper feature to format the citations and 
bibliography from your ODT or RTF file.

EndNote Installation
Follow these instructions to install the EndNote program. 

If you are upgrading from a previous version of EndNote, please 
see “Upgrading from an Earlier EndNote Version” on page 27.

See “Networks and Volume Installations” in EndNote Help for 
information about using EndNote in a network environment, 
licensing, and performing mass installations.

Installing 
EndNote

To install EndNote:
1. Log in to the local machine with administrative rights or as a 

user with program installation privileges. Make sure no 
applications are running, including virus protection software, 
Microsoft Word, or any OpenOffice.org applications. 

The OpenOffice.org Quickstarter may appear in your System 
tray. Right-click on the icon, and then select Exit 
Quickstarter.

2. Start the EndNote installation program.

If you downloaded the EndNote installer: Double click the 
installer file to start the EndNote Setup program. 

If you received EndNote on a CD: Insert the CD into your 
CD-ROM drive. 

The EndNote Setup program will start. If you do not have 
Autoplay enabled, select Run from the Start menu, type 
“d:\setup” (use the drive letter appropriate to the drive 
containing the installation CD), and then press Enter.
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3. Follow the instructions on screen to complete the installation. 
Use the Next button to move forward between the installation 
dialogs.

Welcome: Thank you for selecting EndNote!

Registration Information: If you are installing the full 
version of EndNote, enter your EndNote product key. You 
must enter a valid product key to continue with installation of 
the full version of EndNote. The product key can be found in 
the EndNote X5 CD packaging, or on the order confirmation 
of your digital product. 

If you are installing the Demo version, select the appropriate 
button. You do not need a product key or serial number to 
install the Demo version of EndNote.

User Information: Enter your name and organization.

If you are upgrading from a previous version, you must also 
enter your previous EndNote product key or serial number. 

Read Me Information: Read late-breaking news about this 
version of EndNote.

 End User License Agreement: You must select “I accept 
the license agreement” in order to continue with the 
installation.

Select Installation Type: “Typical” installs only the most 
popular output styles, filters, and connection files. Limiting 
the number of files installed speeds up performance. 
Advanced users can select “Custom” to hand pick the file 
groups to install, and add additional styles, filters, and 
connection files.

Select Destination: By default, EndNote is installed in the 
C:\Program Files\EndNote X5 folder. The Demo version is 
installed in the C:\Program Files\EndNote X5 Demo folder. 
You can use the Browse button to change the folder selection 
if you wish. 

If a previous installation of EndNote is found in the same 
folder, you will be given the option to either back up or 
overwrite the older files. If you back up files, they are placed 
in a Backup folder in the installation folder.

NOTE: If the installer detects a full version (not a demo version) of 
EndNote on your computer, it will give you the option to continue with 
the installation or quit. If you continue, be advised that you will need to 
reinstall your full version of EndNote to use it after you run the EndNote 
X5 Demo version.
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Select Components: (Custom installations only) If you 
selected a Custom installation, see “Selecting Features” on 
page 26.

Select Default Citation Manager: (Microsoft Word 2007 and    
2010 only) If the installer detects Microsoft Word 2007 or 
2010, it asks whether to “Use EndNote as my default citation 
manager.” Cite While You Write will be installed in Word 
2007 or 2010 in any case, but when this item is selected the 
installer will hide Word’s native Citations and Bibliography 
commands (the group normally found on the References tab 
in Word) in order to avoid confusion for the user. 

Ready to Install: You can still click Cancel to stop the 
installation. Once you click Next, the installation program will 
begin installing EndNote files.

4. On the final “EndNote X5 is Successfully Installed” dialog, 
click Register to register your copy of EndNote, and then 
click Finish to close the installation program.

To make sure the program installed correctly, see “Checking 
Your Installation” on page 29.

Installed Files The full EndNote installation includes the following default 
folders and files.

Program Folder
C:\Program Files\EndNote X5, or
C:\Program Files (x86)\EndNote X5 (64-bit Windows versions)

 EndNote.exe application file

 EndNote.chm Help file
You can double-click the file to view it. In the EndNote 
program, select EndNote X5 Help from the Help menu.

Pressing the F1 key on your keyboard or clicking the Help or 
? button in the program brings up a context-sensitive topic.

 GettingStartedGuide.pdf gives a tour of the program

 EndNoteHelp.pdf is a compilation of all the Help topics in the 
online Help system

 Readme.txt text file contains late-breaking news

 Examples shortcut folder
This is a shortcut to an Examples folder that contains sample 
files to follow when using the guided tour found in Chapter 3 
and the Getting Started Guide. You can also use samples to 
experiment while learning EndNote.
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 Styles folder
This folder contains bibliographic styles for formatting 
citations and a bibliography. A Typical installation includes 
only the most popular styles. With a Custom installation, you 
can choose from a full collection of over 4,500 bibliographic 
styles.

 Connections folder
This folder contains connection files to connect to and search 
online bibliographic databases. A Typical installation 
includes only the most popular files. With a Custom 
installation, you can choose from a collection of thousands.

 Filters folder
This folder contains import filters for importing text files 
downloaded from online bibliographic databases. A Typical 
installation includes only the most popular files. With a 
Custom installation, you can choose from a collection of 
hundreds.

 Terms Lists folder 
This folder contains journal abbreviation term lists. These 
lists contain thousands of journal names and standard 
abbreviations. Import a list into your library’s Journals term 
list to use the abbreviations in your bibliographies.

 Spell folder 
This folder contains spell check dictionaries for the EndNote 
spell checker.

 Templates folder 
This folder contains Microsoft Word templates to quickly set 
up your papers for electronic submission to publishers.

 Various additional folders and files are installed to support 
the EndNote program and to integrate EndNote with other 
software programs.

Shared Folder
Open the Shared Documents or Public Documents folder in 
Windows Explorer to find the EndNote folder located at:

Windows 7:  C:\Users\Public\Documents\EndNote

Windows XP:  Documents and Settings\All Users\Shared 
Documents\EndNote

Windows Vista:  C:\Users\Public\Public Documents\EndNote

 Examples folder
This folder contains a sample library and other sample 
documents and graphics to use while learning EndNote.
24 Chapter 2: Windows EndNote Installation



 You may want to use the shared EndNote folder to store your 
libraries so that they are available to all users on your 
computer.

Personal Folder
Open the My Documents or Documents folder in Windows 
Explorer to find the EndNote folder located at:

Windows 7:  C:\Users\UserName\Documents\EndNote

Windows XP:  C:\Documents and Settings\[UserName]\My 
Documents\EndNote

Windows Vista:  C:\Users\[UserName]\Documents\EndNote

These folders are created when you create or modify a file:

 Styles folder contains new or modified bibliographic styles

 Connections folder contains new or modified connection files

 Filters folder contains new or modified import filters

While the Program Files folder contains the default styles, 
connection files, and filters, your personal EndNote folder 
contains those files that you have created or modified. This 
prevents changes to the original files, and assures that you will 
not inadvertently delete a customized file when you remove or 
upgrade the EndNote program. It also allows you to make 
changes to files even though you may not have administrator 
access to modify files in the Program Files folder. EndNote 
displays a single list of the files found in both locations. If a file of 
the same name appears in both locations, EndNote will display 
only the file found in your personal folder.

You can change your personal folder locations. See “Folder 
Locations” in EndNote Help for more information.

Preferences Folder
Depending on your settings, these folders may be hidden from 
view in Windows Explorer. 

Windows 7:  C:\Users\[UserName]\App Data\Roaming\EndNote

Windows XP:  C:\Documents and Settings\[UserName]\
Application Data\EndNote

Windows Vista:  C:\Users\[UserName]\App 
Data\Roaming\EndNote

While many EndNote preferences are stored in the Windows 
registry, some are stored in your personal preferences folder. It 
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contains the connect.log file that records your latest online 
search, the RefTypeTable.xml file that stores your reference type 
preferences, saved search strategies, and various other settings.

Custom 
Installations/
Adding 
Content Files

Although we recommend that you use the Typical installation 
option to install EndNote, the Custom installation option can be 
useful if you are low on disk space, or if you need to reinstall only 
certain EndNote components, or if you would like to add 
additional content files (output styles, import filters, and/or 
connection files).

To perform a new custom installation:
1. Follow the instructions for “EndNote Installation” on page 21. 

2. On the Select Installation Type dialog, select Custom. 

3. From the Select Features dialog, read “Selecting Features” 
on page 26 to determine what you would like to select or 
deselect for your installation.

NOTE: If the installer detects another copy of EndNote in the 
destination folder, it gives you the option to either backup or remove 
older files during the installation. When doing a custom install, only 
selected components are affected. For example, if you are installing 
only the Anthropology styles, and you choose to remove older files, only 
the older Anthropology styles are removed; no other part of the 
installation is affected.

To install components after EndNote is already installed:
1. Log in to the machine with administrative rights or as a user 

with program installation privileges.

2. Do one of these:

 Start the EndNote installation program.

 From the Windows Start menu, select Control Panel. 
Then select Add or Remove Programs. In the list, click 
EndNote X5, and then click Change.

3. On the Application Maintenance dialog, select the Modify 
option, and then click Next.

4. From the “Select Features” dialog, expand the list of items, 
and then select or deselect the EndNote features for your 
installation.

Selecting Features
There are several major categories of components that can be 
installed with EndNote.
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The components you can select for installation include:
EndNote Application
 EndNote Program
 Sample Files

 EndNote Help
 Getting Started Guide
Word Templates/Add-ins: 
 Templates for Microsoft Word

 Cite While You Write for Microsoft Word
OpenOffice.org Extension

Additional Styles: These formats for creating bibliographies 
are grouped by type.

Additional Connections: These files for directly retrieving 
references from online reference databases are grouped by 
information service provider.

Additional Filters: These files for importing text files of 
reference data are grouped by information service provider.

Spelling Dictionaries: These are dictionaries available for 
the spell checker.

Click the plus sign next to each category to display a detailed list 
of items. For each category or subcategory, click the triangle next 
to the name to select from the available installation options. To 
install a feature, select one of these:

 Will be installed on local hard drive.

 Entire feature will be installed on local hard drive.

Upgrading from an Earlier EndNote 
Version

Before you begin, back up any custom styles, import filters, and 
connection files that you do not want overwritten.

We strongly recommend that you uninstall any earlier version of 
EndNote before you install EndNote X5. See “Uninstalling 
EndNote” on page 31. 

NOTE: If you do not uninstall your earlier version of EndNote, then the 
Setup program will install EndNote X5 in its own folder and call the 
folder EndNote X5.
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During installation, you will need to enter both your new EndNote 
product key (located in the EndNote X5 CD packaging or on the 
order confirmation for your digital product) and your old product 
key or serial number. Note that the Demo version of EndNote 
does not require these.

Install the upgrade just as you would a new installation. See 
“EndNote Installation” on page 21.

Backing Up or 
Replacing 
Files

If you try to install EndNote X5 in the installation folder of an 
earlier version of EndNote, the program alerts you and gives you 
two options.

 Backup older files: EndNote X5 provides complete, 
updated sets of style, filter, and connection files, but if you 
want to keep any of your older modified files to use with 
EndNote X5, you should select this option. Doing so has 
EndNote create a Backup folder in the EndNote folder and all 
of the styles, filters, and connection files from your older 
installation are copied into that folder. After installing 
EndNote, you should move any of these files that you want 
to use into the Styles, Filters, or Connections folders installed 
with EndNote X5.

 Remove older files: If this option is selected, Setup replaces 
all of the styles, filters, and connection files from your existing 
EndNote installation with the new ones included with 
EndNote X5. Do not select this option if you have custom 
styles, filters, or connection files that you want to save. If they 
have the same names as any of the files to be installed, the 
installer will overwrite them with the new files.

NOTE: No matter which option you choose, your libraries will not be 
deleted nor will any non-EndNote files in the EndNote folder.

Opening and 
Converting 
Old EndNote 
Libraries 

EndNote X5 opens and uses libraries created with EndNote 8 
and later. It converts libraries created with even earlier versions 
of EndNote to the latest file format. 

To convert an old EndNote library (created before version 8):
1. Start EndNote.

2. From the File menu, select Open, and then select Open 
Library. 

3. On the file dialog, locate and highlight the old library, and 
then click Open.
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EndNote will warn you that the selected library was created 
with an older version, and will ask for permission to convert it. 

4. Click OK to convert the library. Name the new library and 
click Save. The conversion makes a copy of the original 
library in the latest file format, and leaves the original library 
intact.

Using Old 
Style, Filter, 
and 
Connection 
Files

EndNote X5 can use custom styles, filters, and connection files 
that were created with EndNote versions 4.0.1 - X5. Once you 
edit and save one of these files with EndNote X5, it is converted 
to the latest format, which can be used with EndNote versions 8 
to EndNote X5.

All of the styles, filters, and connection files supplied with 
EndNote X5 have been updated to the latest format. The new 
filter and connection files may be used by previous versions of 
EndNote, but you cannot edit EndNote X5 styles in previous 
versions of EndNote. 

Checking Your Installation

To Begin 
Using 
EndNote

From the Start menu, select All Programs > EndNote > EndNote 
Program.

First, a dialog may ask whether you want to open a new EndNote 
Web account or integrate with an existing EndNote Web account. 
For information about EndNote Web, see “Transferring 
References between EndNote Web and EndNote” in EndNote 
Help.

Next, a dialog may ask you to open a library file. You can create 
or open an EndNote library, or select Cancel or Close. A Sample 
Library is provided in an Examples folder to help you get familiar 
with EndNote. 

To check the version number of EndNote, select About EndNote 
from the Help menu. Click the splash screen to clear it. 

If you have trouble accessing the program, repeat the installation 
steps to verify that the program was correctly installed

Checking Cite 
While You 
Write Support

To see whether Cite While You Write is correctly installed, start 
Microsoft Word or the OpenOffice.org Writer. 

 In Word 2003, click on the Tools menu to see EndNote 
commands on an EndNote X5 submenu. 
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 In Word 2007 and 2010, you should see an EndNote tab.

 In OpenOffice.org Writer, you should see EndNote 
commands on an EndNote X5 menu. 

NOTE: Cite While You Write commands may not be available if you 
installed or upgraded your word processor after installing EndNote.

1. Log in to the machine with administrative rights or as a user 
with program installation privileges.

2. Make sure that all Microsoft Office and OpenOffice.org 
applications are closed, including any Quickstarter 
applications.

The OpenOffice.org Quickstarter may appear in your System 
tray. Right-click on the icon, and then select Exit 
Quickstarter.

3. From the Windows Start menu, select Control Panel.

4. Select Add or Remove Programs.

5. Highlight EndNote X5, and then click Change. 

6. Select Repair, and then click Next. 

Your entire EndNote installation is checked and repaired as 
needed. For more information, see “No EndNote commands in 
Word” in EndNote Help.

Automatically Updating Files
You can automatically update EndNote X5 when incremental 
program enhancements are available. 

To update your copy of the EndNote program:
1. Open a connection to the Internet. 

2. From EndNote’s Help menu, select EndNote Program 
Updates. 

The wizard checks for an update, lets you know whether an 
update is available, and then downloads the file(s) and applies 
the update to your EndNote installation.

NOTE: You also have the option to download the latest content files at 
any time from our Web site at http://www.endnote.com. We continually 
update output styles, filters, and connection files. 
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Uninstalling EndNote
Before you remove EndNote, back up your libraries and any 
other files you have created or customized. 

For volume and site license installations, see “Licensing of 
Volume Copies” in EndNote Help.

Uninstalling 
Word 2007 
and 2010 
Settings

Word 2007 and 2010 settings are typically registered during 
installation of the EndNote program, and in those cases they will 
also be uninstalled along with the program. You can jump to the 
next section called “Uninstalling the EndNote Program” on page 
31 for more information.

If you used the Configure EndNote utility for a specific user 
account, to suppress the “Citations and Bibliography” group on 
the References tab in Word 2007 or 2010, you should use that 
utility again to uninstall. 

To uninstall Word 2007 or 2010 settings:
1. Log on to the workstation as the current user. You do not 

have to be an administrator.

2. Launch the Configure EndNote utility. You can do this in one 
of these ways:

 From the Windows Start menu, select All Programs > 
EndNote > Configure EndNote.

 Go to the EndNote program folder and double-click 
Configure EndNote.exe.

3. Select Remove all EndNote components for me, and then 
click Next. 

4. Continue through the uninstall process as instructed.

This uninstalls a single Word 2007 or 2010 setting, and only for 
the current user.

Uninstalling 
the EndNote 
Program

To uninstall EndNote:
1. Log in to the machine with administrative rights or as a user 

with program installation privileges.

2. From the Windows Start menu, select Control Panel.

3. Select Add or Remove Programs (Windows XP) or Programs 
and Features (Windows Vista or Windows 7).

4. In the list of currently installed programs, select EndNote X5.
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5. Click Remove (Windows XP) or Uninstall/Change (Windows 
Vista or Windows 7).

Or, you can uninstall by using the EndNote installation 
program:
1. Log in to the machine with administrative rights or as a user 

with program installation privileges.

2. From your EndNote CD, run Setup.exe.

3. On the Application Maintenance dialog, select Remove, and 
then click Next.

4. Click Next again to begin removing EndNote.

The uninstall procedure removes only files, groups, and icons 
installed by the EndNote installer the last time it was run. For 
example, if you used the installer’s Custom installation option to 
reinstall only style files, the Uninstall program removes only style 
files. 

To remove any modified EndNote files that remain:
We purposely do not remove any EndNote libraries or 
customized files. You can manually delete these files from 
Windows Explorer from the following folders.

Windows XP
C:\Program Files\EndNote X5
C:\Documents and Settings\All Users\Shared 
Documents\EndNote
C:\Documents and Settings\[UserName]\My 
Documents\EndNote
C:\Documents and Settings\[UserName]\Application 
Data\EndNote
Windows Vista
C:\Program Files\EndNote X5
C:\Users\Public\Public Documents\EndNote
C:\Users\[UserName]\Documents\EndNote
C:\Users\[UserName]\App Data\Roaming\EndNote
Windows 7
C:\Program Files\EndNote X5
C:\Users\Public\Public Documents\EndNote
C:\Users\[UserName]\Documents\EndNote
C:\Users\[UserName]\App Data\Roaming\EndNote

NOTE: If you are using a 64-bit version of Windows, your EndNote 
program folder will be: C:\Program Files (x86)\EndNote X5.
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Chapter 3: Introduction to an EndNote Library
This chapter covers the basics of working with EndNote. In 
particular, you will learn how to:

 Start EndNote and open a library.

 Sort the reference list.

 Select, open, and close references in the EndNote library.

 Save references to custom groups.

 Quit from the EndNote program.

Start EndNote To start the EndNote program and open the sample library:
1. Macintosh: Open the EndNote X5 folder and double-click 

the EndNote program icon. By default, the EndNote X5 folder 
is installed in the Applications folder on your hard drive.

Windows: From the Start menu, select All Programs > 
EndNote > EndNote Program. 

NOTE: If this is the first time you have used the EndNote program, a 
dialog appears and prompts you to set up EndNote Web. For this 
section of the tour, skip setting up EndNote Web.
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The following dialog appears prompting you to open a 
reference library.

NOTE: If you have set a favorite library to open automatically, that 
library will open instead of the dialog shown above. If this happens, 
close the library. From the File menu, select Open > Open Library. 
Continue with step 3.

2. Click the File Cabinet icon.

3. In the file dialog, locate and open a reference library:

Macintosh: Navigate to the EndNote X5 folder, select the 
Examples folder, and then click Open.

Windows: Use the Look In menu to find the EndNote X5 
Examples folder. 

 Select the C: drive and Open.

 Select Program Files and Open. 

 Select the EndNote X5 folder and Open. 

 Select the Examples folder shortcut and Open. The 
Examples folder is actually in your Shared Documents or 
Public Documents folder.
36 Chapter 3: Introduction to an EndNote Library



The example library is shipped to you as a single 
compressed file called Sample_Library_X5.enlx. 

Open the Sample_Library_X5.enlx file and EndNote extracts 
the uncompressed library files (Sample_Library_X5.enl and 
Sample_Library_X5.Data) for viewing.

If you have previously opened the compressed sample 
library, select Sample_Library_X5.enl, and then click Open.

If your folder settings are not set up to show file extensions, 
determine the file type based on the icons indicated in the picture 
below.

Uncompressed Library
Compressed Library
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The Library 
Window

When you open the sample library you will see the Library 
window listing all of the references that the library contains.

The Library window includes three panes:

Reference List pane: Displays a multi-column list of references. 
By default, the first column in the reference list shows a paper 
clip icon for references that include an attached file in the File 
Attachments field. This is followed by:

 Author’s last name, first name, initial (all names are shown)

 Year

 Title

 Journal name or secondary title

 Reference type

 URL

Move column dividers to adjust column widths
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 Last Updated

NOTE: You can changes the order of the fields that display in the 
reference list by selecting from the Endnote X5 menu (Macintosh) or 
Edit menu (Windows) Preferences > Display Fields.

Groups pane: Displays various groups of references for easy 
retrieval.

Tab pane: Displays a Preview tab to view formatted references, 
a Search tab for searching either the current library or an online 
database, and a PDF & Quick Edit tab for quickly editing and 
viewing PDF files attached to a reference.

The information displayed in the reference list, as well as the font 
used for the display, can be changed using EndNote 
Preferences. Chapter 4 provides more information about 
customizing the Library window.

You can browse through the reference list by first selecting a 
reference, and then using the scroll bar, the scroll arrows, or the 
Page Down, Page Up, Home, End, and Arrow keys.

Preview 
References

You can easily see more detail about a reference by highlighting 
the reference and viewing the Preview pane at the bottom of the 
Library window.

To preview a reference:
1. First, if you do not have a Tab pane in the window, click the 

Show Tab Pane button at the bottom of the window, and then 
click the Preview tab. 

2. For this example, click the reference titled “Bats: Biology, 
behavior, and folklore.”

The Preview tab uses the current output style to display the 
selected reference as it will be formatted for a bibliography. 
EndNote’s output styles represent the rules for creating 
bibliographies for a variety of journals and other publications. 
The styles determine how your references look when you 
print, export, preview, or create bibliographies.
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3. To select a different output style to apply to the reference, go 
to the toolbar and select Numbered from the Output Styles 
menu.

Only one reference is displayed in the Preview pane. If multiple 
references are selected, only the active reference (surrounded 
by a dotted line) is displayed.

Macintosh Toolbar

Windows Toolbar

Output Style menu
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When the Tab pane is showing, a Hide Tab Pane button is 
available at the bottom of the window. You can click the Hide Tab 
Pane to hide the Preview tab and the other tabs. 

Sort the 
References

References can be easily sorted by clicking on a column heading 
such as Author, Year, or Title. 

To change the sort order:
1. Click the Author column heading to change the current 

Author sort from ascending order to descending order.

NOTE: This example shows references that include Japanese 
characters. EndNote uses Unicode to encode special characters, so 
that data is easily translated between platforms, programs, and 
languages. If boxes appear instead of characters, you may need to 
change the EndNote display fonts to a Unicode font. You will learn how 
to do this in Chapter 4: "Setting EndNote Preferences". If you are 
running Windows, you may need to install special Windows Language 
Packs for some display elements. Consult your Windows 
documentation for more information about Language Packs.
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2. Click the Year column heading to see the references sorted 
in ascending order based on the year of publication.

3. Click the Year column heading again to reverse the sort order 
and see the references sorted in descending order.

4. Click the Author column heading to return the sort order of 
the library to an alphabetical list sorted by the author names. 

Select and 
Open a 
Reference

To work with specific references, you must first select them in the 
Library window.

There are different ways to select a reference, such as:

1. Clicking on the reference using the mouse;

2. Using the arrow keys; or 
3. Typing the first few letters found in the field by which the 

library has been sorted.
To see how this works, click any reference to select it. Press the 
Up or Down Arrow to select the previous or next reference.

To quickly find and display a reference:
1. Select the first Argus reference in the list. Now that the 

reference is selected, there are a number of things you can 
do with it, such as view its contents, copy, cut, delete, or edit 
it.

2. Open the selected Argus reference by pressing the Return 
key (Macintosh) or Enter key (Windows) or by using the Edit 
References command on the References menu. You can 
also open a reference by double-clicking on it in the 
reference list.
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The Reference window opens to display all of the information 
associated with the reference. 

This is where you enter or edit information for a reference. 

To view the rest of the reference, use the mouse to scroll down 
the Reference window or press the Tab key to move forward from 
one field to the next. 

 Press Shift+Tab to move backwards through the fields. 

 Click the Toggle Empty Fields button (Macintosh) or Show 
Empty Fields / Hide Empty Fields button (Windows) to toggle 
between showing all fields in the reference and only those 
fields that contain data.

Close the 
Reference

Close the reference. You can do this in one of these ways:

 Click the X Close button (Windows) in the upper corner of the 
Reference window (not the outer close button for the library) 
or the red Close button (Macintosh) in the upper left corner 
of the window.

 From the File menu, select Close Reference. 

Show or Hide empty 
fields in the reference.

Click and drag to resize the window.
Note that all windows in EndNote are
maximized when opened.
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 From the keyboard, press Command+W (Macintosh) or 
Ctrl+W (Windows). Note that many of the menu commands 
have a keyboard equivalent next to them.

EndNote prompts you to save your changes. Click Yes to save 
your changes.

PDF & Quick 
Edit Tab

About the Quick Edit Pane
You can quickly edit your references by clicking on the PDF & 
Quick Edit tab. Most functionality is the same as working in the 
Reference window. Enter text in a field by clicking on the field. All 
commands are available via the menus including contextual 
menus.

The Quick Edit pane displays the contents of the highlighted 
reference. Each part of the reference is stored in its own field, 
and the reference type is displayed below the title bar.

About the PDF Viewer Pane
The PDF Viewer pane allows you to open and view PDF files 
attached to the current reference.

Let’s attach a PDF file to the reference

1. Place your cursor inside the PDF Viewer pane. Note that a 
message displays that says: “There are no PDFs attached to 
this reference.”

2. Press Ctrl+Alt+A to open a “Select a File” dialog. 
Alternatively, you can click the paper clip icon, and then 
select Attach PDF from the menu.

3. Navigate to the folder Program Files\EndNote X5 (Windows) 
or to Applications/EndNote X5 (Macintosh).

4. Notice the check box titled “Copy this file to the default file 
attachment folder and create a relative link.” Make sure this 
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box is selected so that EndNote will make a copy of the file 
to store with the library. That way, the attached file is always 
available to you, even when you move the library.

5. Select the file titled GettingStartedGuide.pdf. 

6. Click Open to insert the file into the reference.

7. To save the PDF file, navigate away from the current 
reference by clicking on another reference in the library list.

8. Select the Argus reference to display the Getting Started 
Guide in the PDF Viewer pane.

EndNote automatically opens the first PDF file attached to a 
reference when you select the PDF & Quick Edit tab.

A floating toolbar appears within the PDF Viewer pane that 
displays the following icons.

Windows 
Floating Toolbar
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The options include:

 PDF Attachments (Paper Clip icon with contextual menu)

 Save PDF

 Print

 Previous Page \ Next Page

 Go to (page)

 Zoom Out \ Zoom In

 Rotate Counterclockwise \ Rotate Clockwise

 Sticky Note

 Highlight Text

 Find (search PDF).

You can also right-click within the PDF Viewer pane to open a 
contextual menu that includes many of these options.

Let’s create a sticky note
1. Select the Sticky Note icon from the floating toolbar.

2. Navigate to the section in the PDF where you want to add 
the sticky note. 

3. Click the left mouse button to display a Sticky Note icon.
4. Double-click the Sticky Note icon to display a Sticky Note 

text box. 
5. Enter your comments in the Sticky Note text box.
6. Click the Save icon in the floating toolbar. Click Yes when 

Macintosh 
Floating Toolbar
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prompted.

See “The PDF & Quick Edit Tab” in EndNote Help to learn more 
about the PDF Viewer and Quick Edit features.

Save 
References to 
a Custom 
Group

The left pane of the Library window lists groups of saved 
references. The first three groups are permanent.

 All References displays all of the references in the library.

 Unfiled contains references that are not part of a custom 
group.

 Trash contains references that have been deleted from the 
library but not yet permanently eliminated.

Below the permanent groups, you can create group sets to 
organize up to 5,000 custom, smart, and combination groups in 
the library.

 A custom group is built by specifically adding individual 
references to the group. 
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 A smart group is compiled automatically and is based on a 
search strategy. 

 A combination group consists of custom and/or smart 
groups.

The sample library has several custom groups of references. 
Click the group names under the Bats set in the left pane of the 
Library window to view the references in each group. 

Then, click All References to display all of the references in the 
library again.

To create a custom group and add references to it:
1. Display one of the groups in the Paleontology set so that the 

new group will be created in that set.

2. From the Groups menu, select Create Group.

In the Groups pane of the Library window, a group titled New 
Group is now highlighted for editing. 

3. Type “Extinction” as the group name, and then press Return 
(Macintosh) or Enter (Windows) or click in the reference list 
area to save the change. 

There are no references in the new Extinction group.

4. Select the All References group to display all references in 
the library.

5. In the Author column, highlight the first reference by Argus 
and the first reference by Billoski. To select noncontiguous 
references, hold down the Command key (Macintosh) or Ctrl 
key (Windows) as you click on them.

6. Drag the selected references to the new Extinction group and 
drop them on the title of the group. You could go to the 
Groups menu, and then select Add References To > 
Extinction.

Custom groups

Smart group

Group set name
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7. Select the Extinction group to display the two references now 
included in the group.

Click All References to display all of the references in the library 
again.

To move the group to a different group set:
1. Click the Extinction group.

2. Drag it to the Bats group set, and then drop the group 
anywhere in the Bats set.

To delete a custom group:
1. Control+click (Macintosh) or right-click (Windows) on the 

Extinction group name to display a contextual menu, and 
then select Delete Group. 

2. When you are asked to verify the deletion, click Delete.

Only the Group subset is deleted; no references are deleted from 
your library.
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Many of the commands for managing groups are available both 
from the Groups menu and from the right-click contextual menu.

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “Sorting the Library” to learn more about sorting.

 “The EndNote Library” to learn how to change the display of 
the Library window.

 “The PDF & Quick Edit Tab” to learn more about PDF Viewer 
and Quick Edit features.

 “Using Groups” to learn more about creating and managing 
groups.
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Chapter 4: Setting EndNote Preferences
In this part of the guided tour you will learn how to:

 Display EndNote Preferences.

 Set a favorite library to open each time you start EndNote.

 Change the display fonts.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X5.enl as shown in “Start EndNote” on 
page 35.

Access 
EndNote 
Preferences

To view or change the EndNote preferences:
From the Endnote X5 menu (Macintosh) or Edit menu 
(Windows), select Preferences.

Set a Favorite 
Library

You can assign a library to open automatically every time you 
start EndNote. You will find it useful to set the sample library 
(Sample_Library_X5.enl) as your favorite library for now. Later, 
when you create your own library, you can set it as your favorite 
library. 

To set a favorite library:
1. Go to the Endnote X5 menu (Macintosh) or Edit menu 

(Windows), and then select Preferences. 

2. In the list on the left, click Libraries.

3. Select “Open the specified libraries” from the When EndNote 
Starts menu.
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4. Click Add Open Libraries. You should see the full path and 
file name of the sample library (Sample_Library_X5.enl) 
listed at the top of the box.

5. Click Save (Macintosh) or Apply (Windows) to save this 
change. 

While you could click the red Close button (Macintosh) or OK 
(Windows) to leave the Preferences dialog, we are going to 
change another preference first.

Change the 
Library 
Display Font

Pick a different font to display text in the Library window and the 
Reference window. 

To change the display fonts:
1. Go to the Endnote X5 menu (Macintosh) or Edit menu 

(Windows), and then select Preferences. 

2. In the list on the left, click Display Fonts to display a dialog 
with four tabs.

 The Library tab determines the font and size of the 
references listed in the Reference List pane of the Library 
window. 

 The General tab changes the font used to display most 
text that is typed into EndNote such as in the Reference 
or Style windows. The General font is also used for most 
of the previews and information panels in EndNote, as 
well as for bibliographies that are printed or copied 
directly from EndNote. 
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 The Labels tab determines the font and size used for the 
Reference window field labels. 

 The Search tab determines the font and size applied to 
user-entered text on the Search tab.

3. On the Library tab, click the Change (Macintosh) or Change 
Font (Windows) button. 

4. In the Font list, select a different font (for Windows, select 
Arial Unicode MS, if available, since it supports Japanese 
characters). Close the Fonts dialog, and then click Save 
(Macintosh) or OK (Windows) to save the change.

EndNote uses Unicode to correctly handle extended 
characters. By selecting a Unicode font here, you can view 
extended characters in the Library window, such as the 
Japanese characters found in the Paleo library.

5. On the General tab, click the Change (Macintosh) or Change 
Font (Windows) button.

6. In the Font list, select a different font (for Windows, select 
Arial Unicode MS, if available, since it supports Japanese 
characters), and then Save (Macintosh) or OK (Windows) to 
save the change.

7. Click the red Close button (Macintosh) or OK (Windows) to 
leave the Preferences dialog.
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Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “The EndNote Library” to learn how to change the display of 
the Library window.

 “Preferences, Toolbars, & Shortcuts” to learn how to 
customize your version of EndNote.
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Chapter 5: Entering a Reference
In this part of the guided tour you will learn how to:

 Enter a reference into a library.

 Attach a file to a reference.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X5.enl as shown in “Start EndNote” on 
page 35.

Create a New 
Reference

There are various ways to add references to an EndNote library:

 Type the reference information into the Reference window.

 Connect to an online bibliographic database and retrieve the 
references directly into EndNote as demonstrated in 
“Searching an Online Database” on page 61.

 Import text files of references that have been downloaded 
from online bibliographic databases as demonstrated in 
“Importing Reference Data into EndNote” on page 73

Once a library is open, you can add a new reference to it:
1. Click in the reference list, and then from the References 

menu, select New Reference to display an empty Reference 
window.

Reference 
Type list
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New references appear as Journal Article (unless you 
change the default setting). They can be changed to another 
reference type using the Reference Type list at the top of the 
window.

2. Select the Book reference type from the Reference Type 
menu. 

Notice that the Field list changes to reflect the type of 
bibliographic information you would record for a book. Select 
other reference types from the list to see how the list of fields 
changes for each type of source.

Three reference types (Figure, Chart or Table, and Equation) 
are available specifically for cataloging picture files and 
object files, although you can add File Attachments, Figures, 
and Captions to any reference type. 

When you are done looking at different reference types, set 
the reference type back to the Journal Article reference 
type. You are now ready to enter reference information 
beginning with the author names. 

3. Enter author names for the reference. Individual author 
names must be entered one per line.

a. Enter an author name with the first name first. With the 
cursor in the Author field, type:

Tiberius Rex

As you type, EndNote suggests names similar to the one 
you are entering. This is EndNote’s way of using Term 
Lists to facilitate the process of entering new references. 
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NOTE: The auto-complete feature can be turned on or off with EndNote 
Term Lists preferences. It is available for Author fields when you enter 
author names with the last name first.

The name you are entering, Tiberius Rex, is a new author 
in this library, so keep typing until you complete the 
name, and then press Return (Macintosh) or Enter 
(Windows). 

The name appears in red text to indicate that it is a new 
name in the Author term list for this library. When you 
close the reference, it will be added to the Author term list 
and the red text will change to black. You can read more 
about term lists (and how to turn these options on or off) 
in EndNote Help.

b. Enter the second author’s name, but with the surname 
first.

Morre, Nicole

This author’s last name is already in the sample library, 
so as you start typing the last name, you will see 
EndNote complete the name for you.

Press Return (Macintosh) or Enter (Windows) to accept 
EndNote’s suggested author name.

c. For the third author, enter:

de Young, John Robert, Jr.

The first comma separates the last and first name. The 
second comma is inserted before suffix text, to make it 
clear that it is not part of the author’s name for 
manipulation of name order or stripping to initials. Suffix 
text will always print after the other information for this 
author. Press Return (Macintosh) or Enter (Windows).

d. For the fourth author’s name, which in this case is a 
corporate author, enter:

University of California,, Berkeley

Corporate author names are entered with a following 
comma, so they will not be manipulated like personal 
author names. In this case, the corporate author name 
has a comma within the name. We inserted two commas 
to allow for correct formatting. The first comma makes it 
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clear that text up to that point should not be manipulated, 
and the second comma indicates that there is no “first 
name,” yet includes suffix text.

4. Press Tab to accept the author name and move to the Year 
field. Type “2006” as the search term.

5. Continue entering the reference as shown below using the 
Tab key to move to the next field and Shift+Tab to move to 
the previous field. You can also use the mouse to click in the 
desired field. If information is not provided for a particular 
field, leave that field empty.

Title: The scale and the feather: A 
suggested evolution

Journal: Paleontology

Volume: 3

Issue: 1

Pages: 125-128

Date: November 22

Keywords: Feathers
Evolution
Birds

No extra punctuation (such as parentheses around the year) 
or text styles (such as bold or italic) are entered into the 
reference. EndNote adds the necessary punctuation and text 
style changes to the references when it creates a 
bibliography. 

While we are not entering any text into the Abstract or Notes 
fields, you could enter up to 64 K into each of these fields, 
which amounts to 10-12 pages text.

6. Attach a PDF file to the reference. You can attach almost any 
type of file to the File Attachments field of a reference.

Scroll to the File Attachments field, and from the References 
menu, select File Attachments > Attach File to display a file 
dialog. On the file dialog:

a. Navigate to the folder:
Applications/EndNote X5 (Macintosh) 
Program Files\EndNote X5 (Windows) 

b. Notice the check box titled “Copy this file to the default 
file attachment folder and create a relative link.” Make 
sure this box is selected so that EndNote will make a 
copy of the file to store with the library. That way, the 
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attached file is always available to you, even when you 
move the library.

c. Highlight the file titled GettingStartedGuide.pdf.

d. Click Open to insert the file into the File Attachments 
field. A file icon will appear in the field.

You can attach up to 45 different files to a single 
reference. Double-click the file icon to open the file with 
the default program for the file type.

7. From the File menu, select Close Reference to close the 
Reference window. 

8. When prompted to save changes, click Yes. Your new 
reference will appear in the Library window.

A paper clip icon appears next to the reference to indicate an 
attached file.
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Locate 
References 
that Contain 
Attached Files

You can easily locate those references that contain attached 
files.

To locate the references containing attached files:
Click the paper clip icon in the first column heading twice to sort 
records containing attached files at the top of the list. References 
that include a paper clip have one or more attached files. 

You can double-click an individual reference if you would like to 
view the complete reference. When you are done viewing a 
reference, click the Close button.

Click the Author column heading to again order the list by author 
names in ascending (A to Z) order.

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “The EndNote Library” to learn how to create your own 
library.

 “Entering and Editing References” to learn about typing 
references into your library and inserting images.
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Chapter 6: Searching an Online Database
With the EndNote Online Search command, you can search 
online bibliographic databases just as easily as you can search 
an EndNote library on your own computer. The results of your 
searches can be downloaded either into a temporary EndNote 
library or directly into your own EndNote library. 

Another way to search online sources is with the Find Full Text 
command, which locates full text articles for your existing 
EndNote references.

This section will guide you through these basic steps:

 Connect to an online database.

 Search the database and download the references into an 
EndNote library.

 Find and attach the full text article for a reference. 

NOTE: To follow this exercise, you must be at a computer with access 
to the Internet (either dial-up or a direct network connection).

About the PubMed Database
For this lesson, you will connect to PubMed, the U.S. National 
Library of Medicine’s online public access version of their 
MEDLINE database.

For Users With “Dial-up” Internet Connections
This section pertains to you if you use a modem and a phone line 
to connect to the Internet, as opposed to a direct network 
connection.

Connecting: Most setups for dial-up connections are configured 
to automatically dial your information provider and connect to the 
Internet when you use an application that requests an online 
connection (as EndNote’s Online Search command does). 
However, some setups require that you establish an online 
connection (sign on) before choosing EndNote’s Online Search 
command. 

Disconnecting: EndNote disconnects from an online database 
as soon as a search is completed. EndNote will not disconnect 
your Internet connection at any point. You need to shut down 
your connection when you have finished using EndNote’s Online 
Search feature.
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Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X5.enl as shown in “Start EndNote” on 
page 35.

Select a 
Display Mode

You can choose from different display modes in the Library 
window by selecting one of these from the toolbar.

 Integrated Library & Online Search Mode

 Local Library Mode

 Online Search Mode

There are actually two different workflows. You may want to 
always work in Integrated Mode, with all groups and commands 
available, and with online search results downloaded directly into 
your open library. Or, you may want to work primarily in Local 
Library Mode, with Online Groups suppressed until you explicitly 
switch to Online Mode to download references into a temporary 
library.

 In Integrated Library & Online Search Mode, all groups and 
commands are available. When you download references 
from an online database, they are saved directly into the 
open library. 

 In Local Library Mode, the Online Search groups are not 
available. All local library commands are available. If you 
initiate an online search from the Tools menu, the display 
switches to Online Search Mode.

 In Online Search Mode, only the Online Search groups are 
available. When you download references from an online 
database, the references are stored in a temporary library 
until you save them to a permanent EndNote library. This 
allows you to download references from online databases 
and review them without affecting your local library. Many 
library commands are not available in Online Search Mode. 
When you close Online Search Mode, the display changes to 
Local Library Mode.

Try clicking on the three different mode buttons at the left of the 
toolbar to see how the Group pane changes in the Library 
window.

Integrated Library & 
Online Search Mode

Local Library Mode

Online Search Mode 
(Temporary Library)
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To continue the tour, click the left icon to select Integrated Library 
& Online Search Mode so that all groups and commands are 
available. 

Connect to an 
Online 
Database

The first step in searching an online database is connecting to it.

To connect to the PubMed Database:
1. Go to the Tools menu and select Online Search to see the 

available list of online databases. You could also look under 
Online Search in the Groups pane, and then click the More... 
link.

NOTE:  The Groups pane will remember databases you have 
connected to in the past for easy access under Online Search. You can 
also customize a list of favorite databases to search by using the 
Connection Manager.

NOTE: This window displays the connection files available in your 
Connections folders. A Typical installation installs only the most popular 
connection files, but more than 4,100 connection files are available with 
EndNote.

Click to 
show more
info about the
connection file.
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2. Click the Find by Category button (Macintosh) or the Find by 
button (Windows) to view a list of various categories of 
databases to help you locate the one that you need. Or, type 
text into the Quick Search text box and press Return 
(Macintosh) or Enter (Windows).

3. Select the PubMed connection file, and then click Choose. 
You can begin entering your search terms in the fields.

By selecting this connection file, you have directed EndNote to 
connect to the U.S. National Library of Medicine’s PubMed 
database. If for any reason the connection cannot be 
established, EndNote alerts you with an error message and 
closes the connection.

When the connection has been established, EndNote displays a 
Search tab titled, “Online Search - PubMed MEDLINE at PubMed 
(NLM).” The PubMed MEDLINE database is selected and 
EndNote is ready to search.

NOTE: For more detailed information on how to search PubMed, 
see “Importing References from PubMed” in EndNote Help.

NOTE: If you previously set a default configuration for the Search tab, 
the search field lists display the fields you selected as your defaults. If 
one of those default fields is not a valid option for this particular online 
database, the field selection may appear as “Any Field” or “All Fields.”

Search the 
Database

The next step is to enter the search term(s) to find the references 
you need. Searching an online database is very similar to 
searching an EndNote library (with a few exceptions). 

Let’s say you are interested in finding more information about 
fossils for the sample library. 
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To enter the search term(s) and perform the search:
1. In the Groups pane, select PubMed (LMN) 

2. Set the Field list for the first line to MeSH Terms, and enter 
“fossil” into the search text field. The Comparison list for 
online searches is always set to Contains.

3. Click Search. 

EndNote sends the search request off to the online database 
and a summary of the search results is displayed.

The dialog displays the number of references that were found 
to match your search request, and gives you the option to 
retrieve them. 

NOTE: You can halt a retrieval in progress by clicking the Cancel button 
on the Search tab. Records that have been processed up to that point 
already exist in the library.

NOTE: PubMed is updated regularly, so you may find a different 
number of references than illustrated here.

If the result set seems too many, you can refine the search to 
get closer to exactly those references you want. Let’s refine 
this search by looking for just those references that include 

Match Case and Match Words are not available for online searches

Comparison ListField List Search Term
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mention of a “trilobite,” a group of extinct marine animals that 
were abundant in the Paleozoic era.

4. Click Cancel to return to the Search tab.

5. Set the operator at the beginning of the second search line to 
And.

6. In the second search line, select All Fields from the Field list 
and type “trilobite” as the search text.

7. Click Search.

This time fewer references are found.

8. Click OK to retrieve and save the matching references. 

The references are downloaded into your library and appear 
both in the All References group and in a temporary PubMed 
(NLM) group for the PubMed database connection. 
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The temporary PubMed (NLM) group will reset back to 0 
references when you close the library. 

NOTE: If you would prefer to save references to a temporary library 
first, to verify which references you want to save, you would begin by 
selecting Online Search Mode.

NOTE: You can click the triangle icon (Macintosh) or plus or minus icon 
(Windows) next to a group set heading to display or hide the list of 
groups under that heading.

Review the 
References

At this point, you can view the retrieved references to make sure 
you want to keep all of them. You may find that some of the 
references are not helpful for your research.

While you could open each reference individually to scan through 
the bibliographic data, you can also use the Preview tab or the 
Quick Edit pane.
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To quickly look at the new references:
1. Click on a reference in the reference list.

2. Click the Preview tab to display a reference to view.

3. On the toolbar, select the Show All Fields output style from 
the Output Style list.

The Show All Fields style is not bibliographic, but represents 
all of the fields in your references. On the Preview tab, scroll 
through the data in the selected reference.

NOTE: If Show All Fields is not in the Output Style list, then choose 
Select Another Style to go to the Choose a Style dialog. Select Show 
All Fields from the list.

Delete 
Unwanted 
References

Because you are working in the Integrated Mode display, 
references were downloaded directly into the open library. Any 
references you do not want must be deleted. 

NOTE: If you had downloaded references in Online Search Mode, the 
references would be in a temporary library; you would need to highlight 
the references you wanted to keep and copy them into a permanent 
EndNote library.

To delete references:
1. In the PubMed (NLM) group, select two of the displayed 

references by holding down the Command key (Macintosh) 
or the Ctrl key (Windows), and then clicking on the individual 
references. Use Shift+click to select a range of references.
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2. From the References menu, select Move References to 
Trash. The selected references are removed from the library 
and put in the Trash group.

While the references are officially no longer in your library 
(they will not appear in any other group or reference list, they 
are not included in your reference count, and they cannot be 
cited), they are not completely deleted until you go to the 
Groups menu and select Empty Trash. Until you select 
Empty Trash, you can still drag references from the Trash 
group back to your active library.

3. Because you are sure that you want to delete the references, 
click the Trash group, and then go to the References menu 
to select Empty Trash.

4. Confirm the deletion by clicking OK.

5. Click the All References group to return to the full reference 
list, and on the toolbar, set your output style back to 
Numbered.

If you wanted to do another search of PubMed, you could display 
the PubMed group, enter another search strategy, and then click 
Search again. On the Confirm Online Search dialog, you are 
asked, “Clear currently displayed results before retrieving 
records?” This check box simply removes the previous 
downloaded references from the PubMed group; they still exist in 
the library. It is an easy way to see just those references 
downloaded with the current search strategy.

Find the Full 
Text for a 
Reference

Many online sources now supply not only bibliographic 
information, but the full text of the document you are referencing. 
In this exercise, you will find the full text for a reference.

To find the full text for a reference:
1. Click in the list of All References and type “Chiu” to jump to 

the reference by the author Chiu, C.

2. Highlight the reference by Chiu as well as the reference by 
the author Chang, Kenneth.

3. From the References menu, select Find Full Text > Find Full 
Text.

EndNote displays a copyright notice advising you to adhere 
to downloading and usage guidelines as required by your 
information provider. We will use the default EndNote 
settings to search public sources that do not require 
authentication for access.

4. Click OK to begin the Find Full Text search.
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In the left-hand column, under the Find Full Text group set 
heading, you will see a Searching group indicating that a search 
is in progress. This search can work in the background, so if you 
had many references selected, you could continue working in 
your library.

When the Find Full Text search is completed, the Searching 
group is removed. Depending on the results, you may see a 
combination of three different groups under the Find Full Text 
heading.

 Found PDF

 Found URL

 Not found

In this case, EndNote was able to locate a PDF file for one of the 
references.

In the reference list, you can see that the Chiu reference now has 
a paper clip icon next to it indicating an attached file. 

Select the Chiu reference in the library window, and then click the 
PDF & Quick Edit tab to open the PDF in the PDF Viewer pane. 
See “PDF & Quick Edit Tab” on page 44 to learn more about this 
feature.

The Chang reference does not have a PDF icon in the File 
Attachments field. 

NOTE: EndNote did not find a URL for either Chiu or Chang. Had 
Endnote found a URL for either reference, the URL would be added to 
the URL field. The URL would take you to the provider’s Web site where 
either the full text article is available or you will find information about 
how to obtain the full text article.
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Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “Searching Online Databases” to learn about establishing 
connections, searching for references, retrieving references, 
and finding the full text for a reference.

 “Troubleshooting” to learn how to resolve problems 
establishing a connection.

 “Connection Files” to learn about creating and editing 
connection files.

 “Importing References from PubMed” to learn how to import 
records from the PubMed database.
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Chapter 7: Importing Reference Data into 
EndNote

Online searching, described in the previous section, is the 
easiest way to retrieve references from online databases, but not 
all information providers offer that option.

If you have access to an online bibliographic database or a 
university catalog, you can probably use EndNote’s import filters 
to import text files saved or downloaded from these sources. 
EndNote filters are configurable so they give you the flexibility to 
import the reference data you need and eliminate data you do not 
need. 

In this part of the guided tour you will learn about:

 Downloading data in a tagged output format.
 Selecting an import filter and importing data into EndNote.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X5.enl as shown in “Start EndNote” on 
page 35.

Search the 
Database and 
Save the 
References

Often when you search a database, the matching references are 
displayed as text, with no clear indicator between each piece of 
bibliographic information. The PubMed reference below, saved in 
a Citation format, is an example. There is no clear indicator for 
EndNote to be able to differentiate a title from an address or an 
abstract.

Science. 1966 Dec 9;154(3754):1333-1339.

Early Eocene Bat from Wyoming.

Jepsen GL.

    A fossil skeleton of an early Eocene bat, the 
oldest known flying mammal, was found in 
southwest Wyoming. The bat is assigned to the new 
species Icaronycteris index of the suborder 
Microchiroptera. It was apparently of a young 
male whose body was buried in varved marls of the 
Green River Formation, on the bottom of Fossil 
Lake, about 50 million years ago. The bones, some 
as slender as a human hair, show a few 
"primitive" characteristics such as a clawed 
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index finger and a complete phalangeal formula, 
but the bat was fully developed - an anatomically 
precocious contemporary of the dog-sized 
polydactylous horse.

    PMID: 17770307 [PubMed - as supplied by 
publisher]

To use this information effectively, each piece of bibliographic 
information must be consistently tagged so it can be directed to 
the correct EndNote field.

Database providers typically offer several different download 
formats. Regardless of which system you are searching, you 
need to save the references in a tagged format to a text file.

For this tour, we will use a text file of PubMed references that 
were previously downloaded in the tagged MEDLINE format. The 
file pubmed_result.txt is provided in the EndNote Examples 
folder. A single reference in the file appears like this:

PMID- 18198331
OWN - NLM
STAT- MEDLINE
DA  - 20080116
DCOM- 20080313
LR  - 20081121
IS  - 0890-9369 (Print)
VI  - 22
IP  - 2
DP  - 2008 Jan 15
TI  - Understanding of bat wing evolution takes 

flight.
PG  - 121-4
AD  - Department of Genetics, Harvard Medical 

School, Boston, MA 02115, USA.
FAU - Cooper, Kimberly L
AU  - Cooper KL
FAU - Tabin, Clifford J
AU  - Tabin CJ
LA  - eng
GR  - F32 HD 052349/HD/NICHD NIH HHS/United 

States
GR  - R37 HD 32443/HD/NICHD NIH HHS/United States
PT  - Comment
PT  - Journal Article
PT  - Research Support, N.I.H., Extramural
PL  - United States
TA  - Genes Dev
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JT  - Genes & development
JID - 8711660
RN  - 0 (Homeodomain Proteins)
SB  - IM
CON - Genes Dev. 2008 Jan 15;22(2):141-51. PMID: 

18198333
MH  - Animals
MH  - Chiroptera/*genetics
MH  - *Evolution
MH  - Forelimb/anatomy & histology
MH  - Fossils
MH  - *Genetic Variation
MH  - Homeodomain Proteins/*genetics
MH  - Wing/*growth & development
EDAT- 2008/01/17 09:00
MHDA- 2008/03/14 09:00
CRDT- 2008/01/17 09:00
AID - 22/2/121 [pii]
AID - 10.1101/gad.1639108 [doi]
PST - ppublish
SO  - Genes Dev. 2008 Jan 15;22(2):121-4.

Each tag can be mapped to a corresponding EndNote field. If 
data is inconsistently tagged, or poorly delimited, it may not be 
possible to import all of the data accurately. 
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Choose the 
Correct Import 
Filter and 
Import into 
EndNote

Once you have captured and saved your data file in a tagged 
format, you need to identify the proper EndNote filter to import 
the data. There are hundreds of filters included with EndNote; 
each one is designed to read a specific tagged format from a 
specific information provider.

To import the sample PubMed text file into the sample 
library:

1. From the File menu, select Import.

2. Select the file to import.

The 
Windows 
Import 
dialog

The
Macintosh
Import 
dialog
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Macintosh: Browse to the Applications/EndNote X5/
Examples folder and highlight the pubmed_result.txt file.

Windows: Click the Choose button to display a file dialog. 
Browse to the Program Files\EndNote X5\Examples folder, 
and then highlight and open the pubmed_result.txt file.

3. From the Import Option list, select Other Filters to display the 
list of filters supplied in the EndNote Filters folder.

You may want to peruse the list, to get an idea of what filters 
are supplied. You can create new filters or copy and edit 
existing filters.

NOTE: A Typical installation installs only the most popular filters, but 
there are hundreds available with EndNote.

4. Type “PubMed” to jump to the filter in the list.

If the More Info button is available, click it and notice that the 
Comments section at the bottom of the window gives tips for 
downloading references from the selected source.

5. With the PubMed (NLM) filter highlighted, click the Choose 
button.

Click to 
display 
more or 
less info 
about 
the file.
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6. Leave the other two options at their default settings.

Duplicates: Import All

By default, a reference is considered a duplicate if the 
Author, Year, Title, and Reference Type match a reference 
already in the library. You can change the duplicates criteria 
under EndNote Preferences. We will import all references 
regardless of duplicates.

Text Translation: No Translation

This option allows you to specify the text character encoding 
of the file you import. This is important when you import 
references in languages that include extended characters. 
You can also find the correct language encoding information 
by opening the text file in Microsoft Word or another word 
processor.

7. Click Import to import the file.

When the process is complete, only newly imported 
references display in the reference list. This is a good time to 
peruse the new references to make sure they imported as 
expected. You can display the Preview tab to view the 
formatted references, you can open individual references to 
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make sure all information transferred to the correct fields, 
and you can easily edit or delete the new references.

Notice that the focus in the Groups pane has switched from 
the All References group to a new Imported References 
group. 

The Imported References group is a temporary group. It is 
replaced each time you import a new set of references, and 
it is removed when you close the library. The references 
themselves remain in the library unless you specifically 
delete them.

8. To return all of your references to the library display 
(including the newly imported references), select Show All 
References from the References menu or click the All 
References group.
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Downloading 
Records from 
PubMed

The example below gives the recommended download format 
and import option for the U.S. National Library of Medicine’s 
PubMed system.

Information Provider: PubMed
Import Option: PubMed (NLM) Filter
Follow the steps below to download your search results from the 
PubMed Web site and to import them into your EndNote library. 

1. Go to the PubMed Web site in your Web browser at http://
www.pubmed.gov.

2. In the Search field, enter your search criteria to execute 
your search. Click the Search button.

3. On the Results page, select Clipboard from the Send To 
menu in the PubMed navigation bar to save records from 
multiple searches as you work (optional). You can also click 
the Add to Clipboard button to save the first 500 results.

4. Select the needed results and then select File from the Send 
To menu.

5. Select MEDLINE from the Format menu.
6. Select a sort order from the Sort By menu. The default sort 

order is Recently Added.
7. Click the Create File button. This will bring up a dialog box 

allowing you to save your selected references as a text file.
8. Click the Save button to save the file to your computer. Save 

the file somewhere easily accessible such as your 
desktop. The default file name is pubmed_results.txt. You 
may change the file name, but we recommend saving  the 
file with the .txt extension.

9. In EndNote, open the library where you would like to save 
these references.

10. From the File menu, select Import > File to open a dialog 
window.

11. Click the Choose button, and then select the downloaded 
pubmed_result.txt file from your PC.

12. In the Import Option field, select Other Filters, and then 
select the import filter called PubMed (NLM) from the 
Choose an Import Filter dialog.

13. Click the Choose button to go to the Import File dialog.
14. Do not make any selections in the Duplicates and Text 

Translation fields.
80 Chapter 7: Importing Reference Data into EndNote



15. Click the Import button to import your references.
16. Look in your Groups panel to see a new group called 

Imported References. All the references that you 
downloaded from PubMed will appear in this group.

NOTE: In step 4, do not use File > Save from your browser as the file, 
along with the results, will not import.

NOTE: In step 7, if you have a popup blocker enabled, such as the one 
that comes by default from Windows XP Service Pack 2, you may need 
to disable the popup blocker temporarily to allow the PubMed Web site 
to send you the file.

When you close the current library, EndNote removes the 
imported records from the Imported References group.

Direct Export 
from Web 
Pages

Certain Web sites include a download button that will send your 
search results directly to EndNote, pick the correct import filter, 
and start the import process automatically. 

Start by opening the EndNote library into which the data should 
be imported. This “direct export” or “direct download” method 
does away with the additional steps of saving the references to a 
text file, and then importing that file with the appropriate filter. 

The systems listed below provide a direct export of references 
into EndNote. A detailed table of instructions can be found in 
”Direct Export Providers” in EndNote Help. The list keeps 
growing, so contact your information provider to find out whether 
they participate! 

ALEPH Los Alamos National Laboratory
American Psychological 
Association, PsycInfo Online

MicroPatent

Bibliotech.dk Nature
BioMedCentral Nerac
BioOne NISC
Blackwell Synergy OCLC
BMJ OhioLink
Buffalo University OVID
CABI-Direct Oxford Press Journals
Canadian Journal of 
Communication

Pacific Northwest Labs
Chapter 7: Importing Reference Data into EndNote 81



Exporting 
Records from 
Web of 
Knowledge 
and Web of 
Science

You can easily export bibliographic records from the Web of 
Knowledge platform. A subscription to Web of Knowledge is 
required.

Go to the All Databases or Web of Science Search page and 
perform a search using the Topic, Title, Author, or other fields.

1. From the Results page, click the check boxes to select the 
records that you wish to export to EndNote.

2. Go to the Output Records section of the page and select the 
option to output Full Record in step 2.

3. Click the EndNote button.
4. On the Processing page, click the Export button (Internet 

Explorer) to export the records to EndNote. If you are using 
Firefox, select Open With, and then click OK to export the 
records.

5. If a Choose Destination dialog opens, select EndNote, and then 
click OK.

6. At this point, the EndNote program opens, and the records 
are exported to a temporary group called Imported 

CCLR Patent Cafe
Delphion PILOTS
EBSCO PNAS Online
EI Engineering ProQuest
Elsevier RLG
EMBASE Science Magazine
ERIC Scopus
ESDS Government St. John of God, Ireland
Google Scholar Stanford University's Highwire Press
HAPI Telemed
IEEE Thieme
JAMA Web of Science
JISC WebFeat
JSTOR WilsonWeb
Karger Publishing
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References.

NOTE: When you install EndNote, the system automatically installs the 
ISI ResearchSoft - Export Helper plug-in. The plug-in opens a dialog 
window on the Processing Records page that allows you to select a 
reference program (if more than one program is installed) and a 
reference library. If only EndNote is installed, then the system 
automatically exports the records form All Databases or Web of 
Science as explained in step 4 above.

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “Importing Reference Data” to learn about import options and 
about importing references from other bibliographic software 
programs.

 “Filters” to learn how to create or modify filters that map 
downloaded references to corresponding fields in EndNote.

 “Direct Export Formats and Import Formats” to learn about 
tables of instruction for importing reference data from various 
online systems.
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Chapter 8: Searching an EndNote Library and 
Saving it as a Smart Group

In this part of the guided tour you will learn how to:

 Search an EndNote library for a set of related references.

 Save the search strategy to create a smart group that is 
dynamically updated each time you enter or edit a reference.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X5.enl as shown in “Start EndNote” on 
page 35.

Search for a 
Set of 
References

Let us assume that you want to generate a list of all references 
found in the sample library that are about extinction and that were 
published from 2000 to 2010.

To search for references:
1. Make sure that the All References group is displayed.

2. Click the Search tab.

3. The Search tab remembers the last search you entered. To 
clear it, use the Action menu (Macintosh) or the Options 
button (Windows) to select Restore Default. 

4. On the first search line:

a. In the first drop-down list, the Field list, scroll up and 
select Any Field. This means that EndNote will search all 
fields. 

b. In the next drop-down list, the Comparison list, the 
Contains comparison operator means that EndNote will 
search for the string of text anywhere in the field.

c. Type “extinct” as the first search term.

Click the
Action
menu to
display a
list of 
options
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Next, set up the search to find references dated from 2000 to 
2010. 

5. From the Field list in the second search line, select Year; 
from the Comparison list, select Is greater than or equal to; 
and then type “2000” as the search term for the second 
search line.

6. If you do not have a third search line available, click the plus 
sign button next to the last search line to insert another line. 
You can also click and drag the top of the pane to view more 
of the Search tab.

7. From the Field list in the third search line, select Year; from 
the Comparison list, select Is less than or equal to; and then 
type “2010” as the search term. 

8. Notice the “And, Or, Not” logical operator list at the beginning 
of each search line. Select the And logical operator between 
the three search lines. 

Your Search tab should look like this:

This search will find all references containing the text 
“extinct” that also were published between 2000 and 2011. 

Notice that the following check boxes are not selected for this 
search:

Match Case: This option would limit our search to “extinct” in 
lowercase. If it were found capitalized at the beginning of a 
sentence, or all uppercase, it would not match the search.

Match Words: This option would limit matches to full words, 
with no truncation. The word “extinction” would not match our 
search. 

Logical 
Operator List Field list Comparison List Search Terms
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9. Click the Search button to begin the search. In a moment, 
EndNote displays the search results.

The status area at the bottom of the Library window should read, 
“Showing 5 of 5 references in Group.”

Notice in the Groups pane that these search results are 
automatically retained in a Search Results group. This makes it 
easy to display other sets of references, but still go back and 
display your most recent search results. This temporary Search 
Results group will be replaced the next time you run a search on 
the library. When you close the library, this group is removed.

As you enter additional references into your library, you may 
want to keep track of the references that meet this search 
criteria. An easy way to do this is with a smart group as described 
next.

Create a Smart 
Group

You could create a custom group, and then drag your search 
results to the group, but as you entered new references into your 
library, you would need to manually keep updating the custom 
group. Instead, create a smart group that updates automatically.
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The Search tab should still display the search strategy to find 
“extinct” and the publication years between 2000 to 2011.

To use the search strategy to create a smart group:
1. Click the Action menu (Macintosh) or the Options button 

(Windows), and then select Convert to Smart Group.

A Converted Search smart group is created under the first 
custom group set, Paleontology.

2. Type “Extinct” for the Converted Search title, and then press 
Return (Macintosh) or Enter (Windows).

If you have already clicked away from the editable title, you 
can Control+click (Macintosh) or right-click (Windows) on 
Converted Search, and then select Rename Group.

Each time a reference is added to the library or edited, the smart 
group will update as needed.

To show all references again in the library window, click the All 
References group.

Create a 
Combo Group

Let us assume that you want to combine all your custom groups 
and smart groups under the Paleontology group set in order to 
create a combination group.

To create a combination group:
1. In the Groups pane, click on any of the groups in the Pale-

ontology group set.

2. From the Groups menu, select Create from Groups.
3. In the Group Name field, type “Paleontology Combo Group.” 
4. Go to the “Include References in” section of the dialog. In 

the first field, select Earth Studies from the Paleontology 
group set.

5. In the second field, select Eocene, and then select the OR 
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Boolean operator.
6. In the third field, select Excavation, and then select the OR 

Boolean operator.
7. Lastly, in the fourth field, select Fossils, but then select the 

NOT operator.
8. Click the Create button to save your changes. Your combo 

group should appear in the Groups pane.

Your combined group should contain 44 references from the 
following custom groups and smart groups.

 Earth Studies

 Eocene

 Excavation

 Fossils

Notice that your combination group shows six references in the 
Fossils group. However, because we used the Not operator to 
exclude references from this group, those references do not 
appear in the Paleontology Combo Group. Moreover, duplicates 
are excluded from the combination group.

NOTE: If you delete a reference from a combined group, EndNote 
removes that reference from the custom and/or smart group from which 
it originally came. References deleted from a custom group are 
removed from the group, and from the combo group, but not from the 
All References list. References deleted from a smart group are 
removed from the smart group, the combo group, and the All 
References list, and moved to the Trash group.
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Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “Searching and Sorting in EndNote” to learn more about 
searching the EndNote library and saving references in 
groups.

 “Using Groups” to learn more about creating and managing 
groups.
90 Chapter 8: Searching an EndNote Library and Saving it as a Smart Group



Chapter 9: Using EndNote While Writing a 
Paper with Microsoft Word

Continue with this part of the tour only if you use Microsoft Word 
2008 or 2011 (Macintosh) or Microsoft Word 2003, 2007, or 2010 
(Windows). If you use a different word processor, or if you have 
an older version of Word, see one of these EndNote Help topics 
to learn how to cite EndNote references and create 
bibliographies in your papers.

 OpenOffice.org Writer/Cite While You Write (Windows)

 RTF Files/Scanning and Formatting

EndNote’s Cite While You Write feature inserts EndNote 
commands into Word’s Tools menu (or on an EndNote tab in 
Word 2007 and 2010 for Windows) to give you direct access to 
your references while writing in Microsoft Word. The Cite While 
You Write commands enable EndNote to do bibliographic 
formatting to the document that is currently open in Word.

In this part of the tour, you will learn how to:

 Insert EndNote bibliographic citations into your paper and 
create a bibliography.

 Edit citations to suppress author names and add cited pages.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the library 
called Sample_Library_X5.enl as shown in “Start EndNote” on 
page 35.

EndNote will look for matching references in the currently open 
library. While EndNote can start and open your favorite library 
when needed by Word, opening the library first assures you that 
you are citing references from the appropriate library.

Open a 
Microsoft 
Word 
Document

Start Microsoft Word and open a new document. 

While we are not using one for this tour, EndNote does include 
manuscript templates that make it easy to set up your paper for 
electronic submission to a publisher. When you use one of these 
templates to start your paper, many formatting issues are already 
set up for your target publication, such as proper margins, 
headings, pagination, line spacing, title page, font type, and font 
size. 
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For more information about using manuscript templates, see 
“Creating a Word Document Based on a Template” in EndNote 
Help.

Cite EndNote 
References

You are going to start entering some text and citations for this 
tour. This example assumes that your output style is set for 
Annotated. If not, we will show you how to select an output style 
in “Select a Bibliographic Style” on page 95.

To start writing your paper and inserting citations:

1. Open Word and enter the following text as though you were 
writing a paper.

The fossil in question was generally 
regarded to be the 220 million year-old 
remains of tyrannosaurus. Several years ago, 
however, Morehouse overturned this hypothesis 
with the discovery of yet another species. 

Now you are ready to insert a citation. 

2. From the Tools menu, go to the EndNote X5 submenu, and 
then click Find Citation(s). 

Word 2007 and 2010: On the EndNote tab, click the Insert 
Citation icon.

3. The Find & Insert My References dialog appears. Type the 
author name “Morehouse” in the text box, and then click Find 
(Windows) or Return (Macintosh).
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EndNote lists the matching references. 

4. Click the Down arrow on the Insert button to display a menu. 
Select the Insert & Display As: Author (Year) option.

EndNote inserts a citation and Instant Formatting formats the 
citation in the currently selected style and adds it to a 
formatted bibliography at the end of the paper. 

EndNote automatically creates a link from the citation to the 
bibliography. If you have multiple bibliographies (for example, 
one at the end of each chapter and one at the end of the 
document), you can link in-text citations to the reference list at 
the end of each section and/or chapter. See “Select a 
Bibliographic Style” on page 95 for information on how to turn 
this feature on and off.

5. Add more text to the paper:

It is now the undisputed progeny of the 
species at hand.

6. From the Tools menu, go to the EndNote X5 submenu, and 
then click Find Citation(s). 

Word 2007 and 2010: On the EndNote tab, click the Insert 
Citation icon.
Chapter 9: Using EndNote While Writing a Paper with Microsoft Word 93



7. Type the date “1987” into the text box and then click Find 
(Windows) or Return (Macintosh). EndNote searches all 
fields and lists the matching references.

8. Select the reference by the author Turnhouse.

9. Click the Down arrow on the Insert button to display a menu. 
Select the Insert & Display As: Author (Year) option.
EndNote inserts a citation and Instant Formatting formats the 
citation in the currently selected style and adds it to a 
formatted bibliography at the end of the paper. 
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Your document text should look similar to this example. 

9. Assume that you have finished inserting citations in your 
paper. 

Keep your document open in order to select a bibliographic style 
to continue the tour in “Select a Bibliographic Style” on page 95.

NOTE: You can also insert citations in footnotes. First, use the 
appropriate Word command to create the footnote. Then, insert the 
EndNote citation in the footnote. Word controls the placement and 
numbering of the footnote, and EndNote formats the citation based on 
the current style. You must select a style that formats footnotes; for 
example, Chicago 16th.

Select a 
Bibliographic 
Style

You can format your citations and bibliography as many times as 
you like, changing the output style and various other layout 
settings each time.

To select the bibliographic style used for formatting:
1. From the Tools menu, go to the EndNote X5 submenu, and 

then click Bibliography Settings.

Word 2007 and 2010: On the EndNote tab, in the 
Bibliography group, click the bottom corner arrow.
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A Format Bibliography dialog appears where you can select 
a bibliographic style.

Styles contain instructions for how EndNote will format 
citations and the bibliography. Some styles sequentially 
number citations, and then insert a numbered reference list 
at the end of the paper. Other styles insert Author-Date 
citations.

As you can see, there are other formatting options available 
here; you can make changes that override the settings in the 
current output style.

2. The Annotated style should appear in the “With output style” 
field. If not, click the Browse button next to the field, and 
select the Annotated style.

Note that you can sort the list of styles by Name or by 
Category by clicking on a column header within the style 
menu.

3. Click the “Underline linked in-text citations” check box so that 
our citations within a document are visible as hyperlinks with 
underlining and blue text.

4. Click OK to leave the Format Bibliography dialog.

EndNote automatically updates the existing citations and 
regenerates the bibliography in the Annotated style. 
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Your document text should look similar to this example.

NOTE: In the future, if you need to make changes to the paper such as 
adding or deleting citations or text, just do the necessary updates in 
your paper. If you want to change the output style or bibliography layout 
settings, select the Format Bibliography command again. EndNote will 
reformat the in-text citations and generate a new bibliography based on 
your changes.

NOTE: More than 5,000 styles are available. To see the list of styles 
currently installed, select Output Styles from the Endnote X5 menu 
(Macintosh) or Edit menu (Windows), and then select Open Style 
Manager. The Style Manager includes a Get More on the Web button to 
easily locate and download individual styles. Or, you can install entire 
categories of styles with the EndNote Customizer (Macintosh) or 
installation program (Windows).

Edit a Citation If you directly edit a citation or the bibliography, the changes will 
be lost when you Format Bibliography again because EndNote 
reformats according to the rules of the selected output style. To 
make and retain changes to all citations and/or the bibliography, 
modify the output style. However, if you want to make a change 
to an individual citation, select the Edit & Manage Citation(s) 
option as described below.

For some bibliographic styles, the majority of references are 
cited in an “Author, Date” format; but if the author’s name is 
mentioned within the paragraph text, the style dictates that the 
name not be repeated in the citation. In our example, we mention 
Morehouse and the date within the text of the paper.
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To edit an individual citation:
1. In Word, click anywhere on the Morehouse citation.

2. From the Tools menu, go to the EndNote X5 submenu, and 
then click Edit & Manage Citation(s). 

Word 2007 and 2010: On the EndNote tab, in the Citations 
group, select Edit & Manage Citation(s). 

3. Select the Edit Citation tab.

4. From the Format menu (Macintosh) or Formatting menu 
(Windows), Select the Exclude Year option.

5. Leave the Prefix, Suffix, and Pages field blank.

6. Click OK to update the citations in your paper.
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Your document text should look similar to this example. Note that 
the date is gone.

As you are working, remember to often save your document. You 
can continue adding text and bibliographic citations to the paper, 
and EndNote will continue adding to the list of references..

This completes the guided tour. You can close Microsoft Word.

Related 
Sections in 
EndNote Help

See the following topics in EndNote Help for information related 
to this portion of the tour:

 “Microsoft Word/Cite While You Write” to learn about the 
process of citing references and creating bibliographies.

 “Bibliographic Styles” to learn about and install output styles.
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